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INTRODUCTION 

Drug design   

 The drug discovery process involves the identification of the lead structure 

followed by the synthesis of its analogs, their screening to get candidate molecules 

for drug development against a target disease. Despite advances in understanding 

of biological systems, drug discovery is still a long process with low rate of new 

therapeutic discovery. It has been estimated that out of 10000 compounds 

synthesized in the laboratory only one achieves clinical use as a drug. The whole 

process takes around 10-15 years and costs nearly ~$1.2 billion today. This is due 

to the high quality and safety standards that are to be met before getting the FDA 

approval for marketing. In view of the failures in the late phases of drug 

development and the expensive novel technologies involved in the drug’s effects 

on the molecular level and to find new targets, there is a continuous need of newer 

approaches for careful designing of the compounds and for predicting their 

biological activity to prioritize their synthesis. Since the activity of a molecule is 

the result of multitude of factors such as bioavailability, selectivity, toxicity and 

metabolism, the rational drug design has been a dream of medicinal chemists 

since a long time and for the last two decades the goal of medicinal chemistry has 

been dramatically focused on pinpointing the molecule for synthesis.(Leonardo 

G.Ferreira et al.,2015) 

Chemistry of Isatin 

 Isatin is a naturally occurring heterocylic compound. The structure of 

isatin comprises of 8 carbons atoms,indole ring and two oxygen in its ring system. 

Naturally it is found in plants of isatis genus and the species 

Melochiatomentosaaubl, couroupitaguianensis and boronellakoniambonesis. It is 

potential chemical scaffold which undergoes chemical transformation to give 

various products which makes it a synthetically important compound. The 

structure of isatinissimple hencesynthesizing it in laboratory is feasible.(Rajasree 

Gpai et al.,(2016).                 
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Target Enzyme 

 The drug design involves selection of target disease as an essential step to 

find a potent lead to inhibit the enzymes responsible in their mechanism of action. 

The monoamine oxidase (MAO)inhibitors were first developed as antidepressants 

long back. The exact mechanism of action of the enzyme and its inhibitors have 

been studied vastly, and many early theories about their functions have been 

proved wrong. The crystal structures of the two MAO isoenzymes have only 

recently been elucidated, necessitating a radical revision of some long-held ideas 

about how the enzyme interacts with substrates and inhibitors. Some inhibitors of 

the enzyme have been shown to have potential uses in the treatment of several 

neurodegenerative conditions including Parkinson’s and Alzheimer’s disease. The 

reaction catalysed by MAO produces hydrogen peroxide, a source of hydroxyl 

radicals, and MAO inhibitors might, therefore, be useful in managing the outcome 

of stroke and other tissue damage associated with oxidative stress. The activity of 

the enzyme is essential for normal brain development, and there are indications 

that the genetically determined level of activity of  this enzyme influences aspects 

of personality and addictive behaviour. Here, we consider these phenomena in 

terms of our current understanding of the functions of MAO and its 

inhibitors.  

  

 Mitochondrial MAO catalyses the oxidative deamination of a range of 

monoamines, including 5-hydroxytryptamine (5-HT, or serotonin), histamine and 

the catecholamines dopamine, noradrenaline and adrenaline. The reaction 
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produces hydrogen peroxide,  the corresponding aldehyde, and either ammonia (in 

the case of primary amines) or a substituted amine (from secondary amines). For 

example, methylamine, rather than ammonia, is produced from adrenaline. 

Although MAO was suggested to be a metallo-enzyme, containing either iron or 

copper ions essential for activity, it is now known that this is not the case. Two 

isoenzymes of MAO (MAOA and MAOB) are present in most mammalian 

tissues. These were originally distinguished by their sensitivities to the acetylenic 

inhibitors clorgyline and l-deprenyl (Selegiline), and by their substrate 

specificities. Typically, MAOA is inhibited by low concentrations of clorgyline 

and catalyses the oxidation of 5-HT. 

 MAO in peripheral tissues, such as the intestine, liver, lungs and placenta, 

seems to protect the body by oxidizing amines from the blood or by preventing 

their entry into the circulation. MAO-B in the micro vessels of the blood–brain 

barrier presumably has a similar protective function, acting as a metabolic barrier. 

It has been suggested that in the PNS and CNS intra neuronal MAOA and MAOB 

protect neurons from exogenous amines, terminate the actions of amine 

neurotransmitters, and regulate the contents of intracellular amine stores. 

However, studies on the localization of MAO-A and MAO-B in the brain 

necessitated a re-evaluation of earlier ideas that in nerve terminals MAO is 

dominant in neurotransmitter metabolism, whereas in glia it is only involved in 

scavenging after excessive release. The low level of MAO-A in serotonergic 

neurons suggests that glial cells might have an important role indegrading the 

neurotransmitter 5-HT. 
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Fig 1:Mechanism of MAO-A 

 Hence in the present study MAO-A enzyme was selected as a target and 

the crystal structure of it was obtained from the RCSB protein data bank for 

further studies. The potential lead moiety fit to inhibit the MAO-A enzyme was 

identified using the computational tools which could be a effective drug candidate 

for depression. (Moussa B. H. Youdim,2006,P-295) 

Drug Discovery and Development Process 

 The important steps involved in the process of drug discovery are:- 

Lead identification:  

 A critical factor is the search for lead structures. Leads can be obtained 

from natural products, structure directed molecular design, modification of natural 

products, biochemical understanding of the disease process and broad screening of 

synthetic compounds etc.  
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Lead optimization: 

 It involves the identification of lead molecule through the synthesis, and 

testing of derivatives of leads to develop structure activity relationships (SARs), 

calculation of physico-chemical properties and using them for lead refinement 

from techniques like quantitative structure activity relationships (QSARs). 

Modern techniques such as combinatorial chemistry coupled with high throughput 

screening (HTS) provide us an enormous number of new chemical entities (NCEs) 

but these techniques have not been proved cost effective due to high costs of 

reagents in addition to the involvement of costly modern equipments, hence there 

has been a strong demand for the computer assisted techniques which are fast, 

reliable and cheap to rationalize these early steps in drug development.  

Pre-clinical lead development:  

 Drug formulation experiments, in-vivo studies in animals, animal safety 

studies, drug metabolism studies and large scale synthesis come under the 

umbrella of pre-clinical lead development.   

Clinical lead development:  

 It involves the small scale safety and dose ranging test in healthy human 

volunteers (phase I), short term toxicity and followed by development of clinical 

study protocols employing clinical investigations on patients (phase II) and 

comparative double blind studies on patients’ studies (phase III). 

  The process of finding a new drug against a chosen target for a particular 

disease often involves random screening usually by high-throughput screening 

(HTS), wherein large libraries of chemicals are tested for their ability to modify 

the target. For example, if the target is a novel GPCR, compounds will be 

screened for their ability to inhibit or stimulate that receptor. Novel 

pharmacophores can emerge very rapidly from these exercises.  
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 Another important function of these screens is to show the selectivity of 

the compounds for the chosen target by simultaneously screening the hits against 

other targets (cross-screening). Crossscreening is important as the more unrelated 

targets a compound hits, the more likely it is that, it may show toxicity once it 

reaches the clinic. However, it is very unlikely that a perfect drug candidate will 

emerge from these early screening runs. Apart from high throughput screening 

other methods such as virtual high throughput screening (vHTS), where screening 

is done using computer-generated models and attempts to "dock" virtual libraries 

to a target, are also very important as the virtual high throughput screening offers 

very fast, reliable and cost effective solution for large drug discovery projects. 12 

recent Once a lead molecule series has been established with sufficient target 

potency, selectivity and favourable drug-like properties, one or two compounds 

may then be proposed for drug development. The best of these is generally called 

the "lead" compound. The lead compound is further optimized by random trials or 

more judiciously by rational drug design methods. The leads are examined for 

whether these compounds share some common features, chemists/modelers then 

use structure-activity relationships (SARs) to improve certain structural features 

of the lead molecules in order to (i) increase activity against the chosen target (ii) 

reduce activity against unrelated targets (iii) improve the "drug-like" or ADME 

properties of the molecule. A major target in the drug discovery process is to 

develop a high degree of “rationality.” This would represent an intellectually 

rigorous approach incorporating computer-assisted molecular design (CAMD), 

limited but highly focused chemical synthetic effort, and sophisticated biological 

assays. Thus, the drug design process may become significantly less risky and 

more resource efficient. .(Leonardo G.Ferreira et al.,2015) 

Properties calculated using Molinspiration 

  In Molinspiration, we worked with lipophilicity, expressed as clogP, PSA 

index, nRotb and HBA/HBD counts. However, this website offers tools to 

calculate other properties, such as volume and total number of atoms in the 



Introduction 
 

 

Department of Chemistry, SRIPMS 7 

molecule. Analyzing the different approaches, the practical activities on the 

computer were directed to the evaluation of chemical and physicochemical data 

that influence the pharmacokinetic properties of a drug using computational 

techniques. Specific objectives were to allow the students to know these tools, to 

learn how to access them, to search for the structure of drugs and to analyze 

results. The advantage of Molinspiration is to provide more data (polar surface 

area, hydrogen bond donor and hydrogen bond acceptor) than Osiris. The 

advantage of Osiris is to provide values for drug-likeness and drug scores. Both 

are free software easily accessed by any student. (Monique Araújo de 

Brito,2011,P-788) 

PreADMET 

 Over the last 30 years methods of computer aided drug design / discovery 

played a pivotal role in the development of therapeutic drugs. The potential of any 

compound used in therapeutics depends not only on the physical and chemical 

properties but also on Pharmaco dynamics [PD] and pharmaco kinetics [PK] 

aspects of the compounds. Pharmacodynamics correlates health effect of drugs on 

an individual patient while pharmacokinetics records the course of Absorption, 

Distribution, Metabolism and Excretion of a given drug, both are interrelated. 

Over the past 5 decades ADME played a major role in drug design process. 

ADME means absorption, distribution, metabolism and excretion which explain 

about the pharmacokinetics aspects of a drug molecule. There are several 

incidents reporting the attrition of drug discovery projects just because of the poor 

ADME profiles Therefore prior to synthesis and invivo studies, ADME profiling 

found to be more effective. Determination of ADME properties of compounds 

involves lot of experimental procedures to be followed which is time consuming 

and expensive. Therefore Insilco ADME models have been developed. (Ravi 

Kumar K.  et al.,2018). 
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Molecular Docking 

 Molecular docking is one of the most frequently used methods in SBDD 

because of its ability topredict, with a substantial degree of accuracy, the 

conformation of small-molecule ligands within theappropriate target binding site. 

Following the development of the first algorithms in the1980s, molecular docking 

became an essential tool in drug discovery. For example, investigations involving 

crucial molecular events, including ligand binding modes and the corresponding 

intermolecularinteractions that stabilize the ligand-receptor complex, can be 

conveniently performed. Furthermore,molecular docking algorithms execute 

quantitative predictions of binding energetics, providing rankingsof docked 

compounds based on the binding affinity of ligand-receptor complexes. 

Fig 2: 

Molecular docking process. (A) Three-dimensional structure of the 

ligand; (B) Three-dimensional structure of the receptor; (C) The ligand is docked 

into thebinding cavity of the receptor and the putative conformations are explored; 

(D) The mostlikely binding conformation and the corresponding intermolecular 

interactions are identified.The protein backbone is represented as a cartoon. The 

ligand (carbon in magenta) and activesite residues (carbon in blue) are shown in 

stick representation. Water is shown as a whitesphere and hydrogen bonds are 
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indicatedasdashedlines. The identification of the most likely binding 

conformations requires two steps: (i) exploration of a large conformational space 

representing various potential binding modes; (ii) accurate prediction of 

theinteraction energy associated with each of the predicted binding conformations. 

Molecular dockingprograms perform these tasks through a cyclical process, in 

which the ligand conformation is evaluated by specific scoring functions. This 

process is carried out recursively until converging to a solution of minimum 

energy. 

These approaches were based on an increased knowledge of the 

biochemistry involved in depression. This knowledge allowed the various teams 

to decide to develop drugs, now referred to as selective serotonin reuptake 

inhibitors (SSRIs) that selectively inhibited the amine pump that was responsible 

for the reuptake of serotonin in the presynaptic sites in the brain. This would 

increase the concentration of serotonin in contact with the postsynaptic receptor 

and, as a result, should reduce the patient’s depression. In 1971 researchers at H. 

Lundbeck A/S selected talopram as the lead structure for a project to develop 

selective serotonin reuptake pump inhibitors. Talopram had been investigated by 

them as a potential antidepressant, however it had been found to be clinically 

unsatisfactory. A SAR investigation eventually revealed citalopram as the most 

clinically acceptable analogue. This was after less than 50 analogues of talopram 

had been synthesised. It was marketed by Lundbeck in 1989. Other companies 

soon followed suite and a number of SSRIs are now regularly used to treat mild 

and medium depression. Citalopram was first marketed as its racemate but it was 

found that the S-isomer was very much more active than the R-isomer. The former 

is now marketed as escitalopram. SSRIs appear to exhibit fewer detrimental side 

effects than the earlier tricyclic antidepressants (TCAs), such as amitryptiline, 

imipramine and doxepin. However, TCAs are more effective in treating severe 

depression.(Wilson and gisvold’s,2015) 
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                Talopram               Citalopram 

 

Fluoxetin 

The drug design and development involves various stages 

including identification of target disease, selection of potent lead for 

inhibiting the enzyme involved in the mechanistic action and enzyme 

inhibitory activity of the potential scaffold. As many drugs have been 

failed even after marketing due to toxic effects on administration, their 

pharmacokinetic activity was predicted before synthesizing. 

Computational tools are available which eliminates the time utilized for 

trial and error in selecting the lead instead providing a potential scaffold 

with better binding interaction. The enzyme inhibitory activity of the 

predicted potent moiety will be analyzed using invitro or invivo studies. 

The structure activity relationship was also studied to understand which 

part of the lead is responsible for the activity. Extensive studies like QSAR 

was done to design a molecule with very potent activity based on their 

physical or chemical descriptors. The current study was emphasized to 
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design an antidepressant drug which should be safe and effective by 

inhibiting the MAO-A enzyme pathway. The drug likeness was studied 

using the Lipinski’s rule of five and preAdmet was used to analyze the 

toxicity of the drug. The literature survey showed Isatin moieties to be the 

bioisosteres of the marketed antidepressants and hence selected as the lead 

moiety. The molecular docking studies will be used to predict the binding 

energy of the lead with the target enzyme. The compounds with best 

binding energy will be selected for the invitro enzyme inhibitory 

studies.The insilico, synthesis of novel isatin derivatives to inhibit MAO-A 

enzyme as antidepressants was planned to study. 
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REVIEW OF LITERATURE 

Synthesis 

• Synthesis of Isatin- N-Mannich Bases Rojendro S. Vorma ond W. Lewis 

Nobles The synthesis of a series of isatin-N-Mannich bases derived from 

isatin, 5-methyl and 5-bromoisatins a s the active hydrogen component and 

dimethylamine, diethylamine, morpholine, piperidine, N-

ethylcyclohexylamine, 3 azabicyclo[3,2,2]nonane and 3-azabicyclo[3,2, 

]loctane a s the secondary amine moiety . 

                                                   

N

O

O

CH3

N

 

• Chinnasamy Rajaram Prakash , Sundararajan Raja  Design, synthesis and 

antiepileptic properties of novel 1-(substituted benzylidene)-3-(1 

(morpholino/piperidino methyl)-2,3-dioxoindolin-5-yl) urea derivatives 

these compounds 5c revealed protection in MES at a dose of 30 mg/kg 

and100 mg/kg 0.5 h and 4 h after i.p. administration. 

 

N

N

O

O

NH

N
X

O

R

      R=H, X=O 
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Anti depressant  

• Deweshri Rajendrakumar Kerzare, Sunil Sugnomal Menghani, Pramod 

Bhujangrao Khedekar  Synthesis, Characterization, Antidepressant 

Activity and Docking Studies of Some Novel Indole Bearing Azetidinone 

Derivatives an attempt has been made to generate new molecular template 

by linking two pharmacophores (indole and azetidinone), which are likely 

to exhibit  antidepressant-like action in animal models by force swim test. 

(1) 

NH

N O
N

O

Cl

 

• Venkateshwar Rao Jupallya, Venkateshwarlu Eggadib, Sharavana Bhava 

Bandaru Sheshagirib, Umasankar Kulandaivelub, Synthesis and evaluation 

of neuropharmacological profile of  isatin- 3-[N 2-(2-benzalaminothiazol-

4-yl)] hydrazones was investigated by gross behavioural profile, hole 

board, locomotor activity, hypnotic activity, forced swim test, tail 

suspension test and rota rod test in mice (2)         

                               
N
H

N

O

NH

S

N

NH

R

R
1

R
2

 R=5-Cl, R1=OH, R2 =OCH3 
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• Xinghua Zhena,y, ZhouPenga,y, ShuilianZhaoa, YanHana, Qinghao 

Jinb,n, LipingGuana, Synthesis, potential anti convulsant and antidepressant 

effects of  2-(5-methyl-2, 3-dioxoindolin-1-yl)acetamide derivatives evaluated for 

their anti-convulsant activityin a pentylenetetrazole(PTZ) evoked convulsion 

model and anti-depressant activity in the forced swimming test(3) 

N
O

CH3

O

NH

O

 

Anti cancer activity 

• Kara L. Vine, Julie M. Locke,b,c Marie Ranson,Stephen G. Pyneb, and 

John B. Bremner In vitro cytotoxicity evaluation of some substituted isatin 

derivatives  were synthesized  and their cytotoxicity evaluated against the 

human monocyte-like histiocytic lymphoma (U937) cell line in vitro. SAR 

studies identified C5, C6, and C7 substitution greatly enhanced activity 

with some di- and tri-halogenated isatins giving IC50 values <10 µM (4) 

N

O

Br

SCH3

 

•  V. Raja Solomon , Changkun Hua, Hoyun Lee  Hybrid pharmacophore 

design and synthesis of isatin–benzothiazole analogs for their anti-breast 

cancer activity were determined using three different human breast tumor 

cell lines, MDA-MB231, MDA-MB468, MCF7, and two non-cancer 

breast epithelial cell lines, 184B5 and MCF10A.  by SRB assay(5) 
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N

N

O

N R1
R2

S

N

CH3
R

R=H, R1R2 =morpholinyl 

Anticonvulsants 

• Monika Raj, Nagarathanam Veerasamy, Vinod K. Singh Highly 

enantioselective synthesis of 3-cycloalkanone-3-hydroxy-2 oxindoles, 

potential anticonvulsants activity was achieved by using primary-tertiary 

diamine-Brønsted acid catalyst in both organic medium and aqueous 

medium (6) 

                                                           

N
H

O

OH

O

 

• Seshaiah Krishnan Sridhara, Surendra N. Pandeyab, James P. Stablesc, 

Atmakuru Ramesha , Anticonvulsant activity of hydrazones, Schiff and  

Mannich bases of isatin  derivatives 3-(4-chloro-phenylimino)-5-methyl-

1,3-dihydro-indol-2-one  was found to be the most potent compound of the 

series with  87% protection at 100 mg/kg and an ED of 53.61 mg/kg 

metrazol-induced convulsions(MET). (7)      

 

N
O

N
R1

R2

R3  

R1=NO2, R2=4-bromo phenyl, R3=H 
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Anti viral activity                                         

• Marina O. Shibinskaya, Sergey A. Lyakhov , Alexander V. Mazepa , 

Sergey A. Andronati ,Alexander V. Turov , Nadezhda M. Zholobak , 

Nikolay Ya. Spivak Synthesis, cytotoxicity, antiviral activity and 

interferon inducing ability of 6-(2-aminoethyl)-indolo[2,3-b]quinoxalines 

Morpholine and 4-methyl-piperidine derivatives appeared as the most 

active antivirals and the least cytotoxic when compared with tilorone 

standard. 

N

N CH3

CH3

N CH3CH3

N

 

• Ny Sin , Brian L. Venables , Keith D. Combrink , H. Belgin Gulgeze , 

Kuo-Long Yu , Rita L. Civiello , Jan Thuring , X. Alan Wang , Zheng 

Yang , Lisa Zadjura ,Anthony Marino , Kathleen F. Kadow , Christopher 

W. Cianci  Junius Clarke ,Eugene V. Genovesi , Ivette Medina , Lucinda 

Lamb , Mark Krystal , Nicholas A. Meanwell  Respiratory syncytial virus 

fusion inhibitors. Part 7: Structure–activity relationships associated with a 

series of isatin oximes that demonstrate antiviral activity in vivo in which 

18i, 18j and 18n that demonstrated antiviral activity in the BALB/c mouse 

model of RSV infection following oral dosing. 

 

                          

N

N

N

O

N
O R

N
SC

R=CH2CH2F 
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Enzyme activity    

• R. 0. KOBES, R. f. WYATT, AND L. M. NECKERS 

 A Sensitive and Rapid Fluorimetric Assay for Monoamine Oxidase 

 Utilizing High Pressure liquid chromatography. 

  

 This method utilizes high pressure liquid chromatography with 

fluorescence excitation at 280 nm and detection at 330 nm at pH 5.0 of 

indoieacetic acid and 5-hydroxyindoleacetic  acid, the deaminated 

products of two substrates for MAO, tryptamine, and serotonin. The ease 

and rapidity of this assay make it suitable for use where routine enzyme 

determination. (9). 

• Tomio Takeuchi, Keiji Ogawa, Hironobu Iinuma, 

Hiroyuki Suda, Katsuko Ukita, Toshiharu Nagatsu, 

Masaaki Kato And Hamaoumezaw Monoamine oxidase inhibitors 

isolatedfrom fermented broths Cultured broths were screened by 

measuring the inhibition of monoamine oxidase. Using serotonin as the 

substrate, two active agents were isolated from Actinomycetes and shown 

to be pimprinine and trans-cinnamimc acid amide, and a compound 

isolated from a mushroom was identified  using benzylamine as the 

substrate(10) 

• Soheila Kashanian, Mohammad Mehdi Khodaei, and Parvaneh Pakravan 

Spectroscopic Studies on the Interaction of Isatin with Calf Thymus DNA. 

The interaction of native calf thymus DNA (CT-DNA) with isatin was 

studied at physiological pH by spectrophotometric, spectrofluorometric, 

competition experiment, circular dichroism, and viscometric techniques.  

Spectra of CT-DNA indicated deep conformational changes in the DNA 

double helix.(12) 
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PURPOSE AND PLAN OF WORK 
 

 The development of drug for the target disease depression is essential as 

chronic medical conditions and depressive disorders frequently co-occur. 

Depression occurring concomitantly with other chronic diseases incrementally 

worsened health compared with depression alone. Also depression has been 

associated with a doubling of the risk for type 2 diabetes and a 64% increase in the 

risk for coronary artery disease. Depression affects the prevalence, severity, and 

management of co-occurring chronic medical conditions and vice versa. Hence 

there is a huge demand to develop a drug for treating depression by which the risk 

of associated chronic illnesses can be reduced. 

  

 The literature survey availed prime motivation for the present work to 

design a drug which effectively treat the target disease depression which impacts 

the associated chronic diseases also. The in silico drug discovery tools are playing 

a great role in drug discovery to design new molecular entities which are safe and 

effective without consuming much of the research hours. Although various 

enzymes were responsible for the mechanistic pathway for depression, MAO-A 

enzyme was selected as target based on the literature survey. The present work 

focuses on in silico optimization of the lead, synthesis of various lead derivatives 

and invitro inhibition of MAO-A enzyme isolated from rat brain. 
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PLAN OF WORK 

 The present work has been carried out under the following sections.  

 

Phase I: In silico Studies  

➢ Selection of drug target 

➢ Lead Optimization and computation of drug like properties using  

 Molinspiration server 

➢ The target enzyme was identified as MAO-A 

➢ Docking of the Lead molecules with target enzyme using AutoDock 4.2 

 

Phase II:  Synthesis of Isatin derivatives  

 Totally 15 compounds were synthesised using 3 different schemes. 

➢ Scheme 1 

 

The scheme 1 was used to synthesize 5 Isatin derivatives. 

➢ Scheme 2 

 

The scheme 1 was used to synthesize 5 Isatin derivatives. 

➢ Scheme 3 

 

The scheme 1 was used to synthesize 5 Isatin derivatives. 

➢ Spectral Characterization using UV, IR, Mass, NMR was done 

 

Phase III: Invitro Enzyme Inhibitory Study 

➢ The Invitro MAO-A inhibitory activity was evaluated for the synthesised 

 compounds and the results were recorded. 
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MATERIALS 

 

Phase I INSILICO STUDY 

Softwares and data bases used 

➢ Molinspiration (https://www.molinspiration.com/) 

➢ PreADMET properties (https://preadmet.bmdrc.kr/) 

➢ RCSB protein data bank (https://www.rcsb.org/) 

➢ Online SMILES translator (https://cactus.nci.nih.gov/translate/) 

➢ MGL tools- 

• AutoDock 4.2 (http://autodock.scripps.edu/) 

• Python 2.7 molecule viewer 1.5.6 (http://mgltools.scripps.edu/) 

• Cygwin 64 (https://cygwin.com/install.html) 

➢ ChemSketch (https://www.acdlabs.com/resources/freeware/chemsketch/) 

 

Phase II  SYNTHESIS 

Reagent and chemicals  

Isatin, methoxy acetophenone , hydroxy acetophenone, chloro acetophenone,  

methyl acetophenone, resacetophenone, para formaldehyde, ethanol, 

trichloroisocyanuric acid (Hi-Media), nitric acid, sulphuric acid 

Instruments 

• UV visible spectrometer (JASCO V 530) in the department of 

pharmaceutical analysis, college of pharmacy, Sri Ramakrishna institute of 

paramedical science Coimbatore.  

• IR spectrophotometer (JASCO-410) in the department of pharmaceutical 

analysis, college of pharmacy, PSG institute of paramedical science 

Coimbatore. 

• Magnetic stirrer (REMI Elektrotechnik Ltd) in the department of 

pharmaceutical chemistry, college of pharmacy, Sri Ramakrishna institute 

of paramedical science Coimbatore. 

https://www.molinspiration.com/
https://preadmet.bmdrc.kr/
https://www.rcsb.org/
https://cactus.nci.nih.gov/translate/
http://autodock.scripps.edu/
http://mgltools.scripps.edu/
https://cygwin.com/install.html
https://www.acdlabs.com/resources/freeware/chemsketch/
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•  Stirrer (REMI Elektrotechnik Ltd) in the department of pharmaceutical 

chemistry, college of pharmacy, Sri Ramakrishna institute of paramedical 

science Coimbatore. 

• Melting point apparatus in the department of pharmaceutical chemistry, 

college of pharmacy, Sri Ramakrishna institute of paramedical science 

Coimbatore. 

 

Phase III  ENZYME INHIBITORY STUDY 

Reagent and chemicals  

 2M HCL, 5-hydroxy tryptophan purchased in Hi-Media, potassium 

phosphate buffer, phosphate buffer, 0.25M sucrose, n-butyl acetate  

Instruments  

• UV-visible spectrometer (JASCO V 530) in the department of 

pharmaceutical analysis, college of pharmacy, Sri Ramakrishna institute of 

paramedical science Coimbatore.  

•  Vortex mixer (Sri Mahalakshmi scientific & co) in the department of 

pharmaceutical biotechnology, college of pharmacy, Sri Ramakrishna 

institute of paramedical science, Coimbatore. 

• Centrifuge (REMI Elektrotechnik Ltd) in the department of 

pharmaceutical chemistry, college of pharmacy, Sri Ramakrishna institute 

of paramedical science Coimbatore. 
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  Drug design approach 

    Drug designing for MAO-A inhibitor was done in the following phases; 

a. Identification of the target enzyme 

b. Lead optimization (ADME & Mol inspiration) 

c. Docking of the ligand with the MAO-A 

 

A) Identification of the target enzyme 

• Dopamine synthesis and its metabolism by MAO-A. The pathway of 

dopamine synthesis proceeds from tyrosine via tyrosine hydroxylase 

(TH) catalysis to levodopa (l-DOPA), and subsequent decarboxylation 

by dopa decarboxylase (DDC) to dopamine. Dopamine is metabolized 

by intraneuronal monoamine oxidase A (MAO-A), and by glial and 

astrocyte MAO-A . 

• Selective inhibitors of MAO-A (for example, moclobemide) and  do 

not alter the steady-state striatal dopamine levels, although chronic 

treatment with these drugs does enhance dopamine release, possibly 

due to the elevation of endogenous brain amines or receptor 

modulation non-selective MAO-A inhibitors (such as ladostigil) do 

induce highly significant increases in the levels of dopamine in the 

striatum and other regions. 

• In the present work MAO-A was identified as the target enzyme 

which is involved in the decrease in the level of dopamine.By 

blocking this enzyme dopamine level can be increased. The MAO-A 

is downloaded from the protein database PDB(code:2BXS).( 

https://www.rcsb.org/) 

 

B) Lead optimization 

       Lead optimization is a processs in which lead compounds are altered to 

achieve maximum affinity towards the target. To make the lead moiety safer, 

effective and to possess good pharmacokinetic properties structural modifications 

were done.  

       Evaluation of drug likeness( Molinspirtion)  

 Pharmacologically active substituents were characterized by calculating 

steric, hydrophobic, electronic, and hydrogen bonding properties as well as by the 

https://www.rcsb.org/
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drug-likeness score. The theory of drug-likeness score helps to optimize 

pharmaceutical and pharmacokinetic properties, for example, chemical stability, 

solubility, distribution profile and bioavailability. The molecular descriptors have 

developed as rationally predictive and informative, for example, the Lipinski's 

Rule-of-Five (Ro5). The better oral absorption of the ligands and drug likeness 

scores were constructed by getting information about the solubility, diffusion, Log 

P, molecular weight etc. Molinspiration software was used to evaluate the (Ro5). 

Lipinski’s Ro5 calculations 

1) Open the molinspiration home page (http://www.molinspiration.com/). 

2) For calculating using molinspiration, it requires JAVA in the computer. 

3) Click calculation of molecular properties of drug likeness. 

4) Draw the structure of ligand  in the active window. 

5) Click calculate properties and predict bioactivity. 

6) Save the properties. (https://www.molinspiration.com/) 

 

 Evaluation of drug Pre-ADMET 

Procedure 

• Google search  Pre ADMET  

• Click on the link ADME Prediction in the home page, when it redirects to 

login page. 

• Login into the server to get redirected to the page for ADME prediction  

• One can draw the chemical structure of the drug molecule using the tool bar  

• One can also import the structure of a molecule into the tool for predicting 

ADME. The structure of the molecule should be loaded in “mol” format. 

• Once the molecule is open and loaded, click on the calculate button seen at 

bottom right side of the window. 

 

 Calculating the ADME results 

  

Here, one has options like calculate, reset, and clear result. By clicking “calculate” 

button, it will lead to calculation of ADME properties of a drug molecule. By 

clicking the reset button it will allow to reset the view of a drug molecule and clear 

result will clear the result page. It will allow loading of a new molecule without 

confusion. 

 

     

https://www.molinspiration.com/
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There are several methods used in drug selection process to check for intestinal 

absorbtion. Caco-2 model and MDCK cell are referred to as invitro model for 

prediction of drug absorbtion, where the drug has been administered orally. 

PreADMET predicts the permeabilty of Caco-2 cell, MDCK cell, blood brain 

barrier, Human intestianl absorption, skin permeability and plasma protein binding. 

  

Caco-2 cells are derived from human colon adenocarcinoma which has multiple 

drug transport pathways. 

  

Caco-2 permeability in PreADMET  is classified into three classes. 

  

1.  If the permeability value is less than 4, then the molecule is having  

low permeability. 

2.  If the permeability value is between 4 to 70, then the molecule is having  

medium permeability. 

3.  If the permeability value is greater than 70, then the molecule is having 

 higher permeability. 

  

 

 

MDCK cell permeability 

  

MDCK cell refers to Madin-Darby canine kidney cell. Since MDCK cells life span 

is less than the life span of Caco-2 cells, correlation between them is said to be 

high. MDCK cell system can be used as a good tool for rapid permeability 

screening. 

  

MDK cell level of permeability in PreADMET can be classified into three classes, 

  

1. If the permebiality value is less than 25, then the molecule is having 

 low permeability. 

2. If the permebiality value is between 25 to 500, then the molecule is having 

medium permibility 

3. If the permebiality value is greater than 500, then the molecule is having 

 higher permeability. 
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Human intestinal absorption  

  

The intestinal absorption is very important to find the potential candidate and 

PreADMET finds the absorption in percentage. Poorly absorbed compounds return 

0 to 20%, moderately absorbed compounds return 20- 70% and well absorbed 

compounds return 70-100%. 

  

Skin permeability 

  

Skin permeability factor is very important in case of cosmetics for transdermal 

delivery of drugs. PreADMET predicts the invitro skin permeability and the result 

is given as logKp. 

  

Blood Brain Barrier 

  

Predicting whether compounds pass across the blood-brain barrier is crucial in the 

pharmaceutical sphere because CNS-active compounds are the only substances 

which must cross the barrier. This happens in order to avoid CNS side effects in 

the brain. In PreADMET, one can predict rates for BBB penetration in vivo data. 

  

 

 

 

 

PreADMET explains about the absorbtion to CNS as follows. 

  

 
Table1: Absorption level in central nervous system 

  

Plasma protein binding of a drug gives information on not only the drug action but 

also its efficacy and disposition. 
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In PreADMET, plasma protein binding capacity is referred to as 

  

  

Table 2:Binding capacity level interpretation table (value@amirta) 

 

 

C) DOCKING 

For docking study the enzyme was downloaded from the protein database 

where the x-ray crystallographic structure are obtained and the docking 

study were performed with Autodock 4.2 version.  

Step 1  

Ligand file format conversion 

➢ The desire ligand are drawn in ChemSketch.  

➢ Tools→clean structure.  

➢ Tools→generate→SMILES notation. 

➢ Copied the smile notation and uploaded the smiles in online smile translator- 

cactus.nci.nih.gov/services/translate. 

➢ By choosing the required file format and save the file as pdb format. 

 

 

 

Step II 

Protein structure refinement  

 The enzymes monoamino oxidase , were downloaded from RCSB (Research 

Co-laboratory for Structural Bioinformatics) Protein Data Bank and the protein 

was refined before use for docking.  

➢ Opened Accelrys discovery studio viewer. 

➢ File→open→RCSBPDB file. 

➢ View→hierarchy→click water molecules→select all water molecules → 

delete. 

➢ Selected ligand, which was unnecessary and deleted. 

➢ Saved the molecule in a desired location. 
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Step III 

Docking with autodock 4.2 

➢ Opened the refined protein from the location in pdb format. 

➢ Preparation of target and ligand in AutoDock 4.2 

Step IV 

Preparation of protein 

➢ AutoDock 4.2 →File→Read molecule→Choose refined enzyme file. 

Elimination of water molecule carried out by: 

➢ Select→Select from string→Residue (*HOH*) →Add→Dismiss. 

➢ Edit→Hydrogen→Add→Polar only→Ok. 

➢ Edit→charges→Add kollmann charges→Ok. 

➢ File→save→Write pdb→Browse→Save→Ok. 

➢ Edit→Delete all molecules→Continue. 

Step V 

Preparation of ligand 

➢ Ligand→input→open. 

➢ Ligand→torsion tree→detect root. 

➢ Ligand→ torsion tree→show root expansion. 

➢ Ligand→ torsion tree→choose torsions→done. 

➢ Ligand→ torsion tree→set number of torsions→dismiss. 

➢ Ligand→ torsion tree→hide root expansion. 

➢ Ligand→ torsion tree→show/hide root marker. 

➢ Ligand→output→ save as pdbqt file. 

➢ Edit→delete→delete all molecules→ continue. 

Conversion of pdb files of protein in to pdbqt file  

➢ Grid→Macromolecule→Open→Save as pdbqt. 

AutoGrid calculation and creating “gpf” file 

➢ Grid→set map types→ open ligand. 

➢ Grid→grid box→set 60 points in XYZ. 

➢ File→close saving current. 

➢ Grid→output→save as gpf. 

➢ Edit→delete→delete all molecules→continue. 
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Autodock calculation and creating ‘dpf’ file 

➢ Docking→macromolecule→set rigid file name →open. 

➢ Docking→ligand→open→accept. 

➢ Docking→ search parameters→ genetic algorithm→accept. 

➢ Docking→docking parameters→accept. 

➢ Docking→output→ lamarckian genetic algorithm→save as dpf. 

 

Programming of ‘Auto Grid’ and ‘Auto Dock’ execution 

Open Cygwin64 and type as given below: 

❖ cd C: 

❖ cd cygwin64 

❖ cd usr 

❖ cd local 

❖ cd bin 

Program should list out the pdb, pdbqt, gpf and dpf files of an enzyme and ligand 

molecule. 

Then type as: 

❖ ./autogrid4.exe<space>–p<space>ligand.gpf<space> -l<space>ligand.glg 

 If a ligand gets into the spacing of the grid, then the execution of this 

command was;  

✓ ‘Successful completion’ 

Then type as:  

❖ ./autodock4.exe<space> –p<space>ligand.dpf<space> -l<space>ligand.dlg 

 If the ligand binds to the amino acids through 10 different conformations, 

then the execution of this command was; 

✓ ‘Successful completion’ 
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Step VI 

Viewing docking results  

Reading the docking log file.dlg 

➢ Toggle the AutoDock Tools button. 

➢ Analyse→Docking. 

➢ Analyse→Conformations → Load. 

➢ Double click on the conformation for to view it. 

Visualizing docked conformations 

➢ Analyse→Dockings→Play. 

➢ Load dlg file. 

➢ Choose the suitable conformations. 

➢ Analyse→Docking→Show Interactions. 

Obtaining snap shots of docked pose  

➢ File→Read Molecule. 

➢ Analyse→Dockings→Open dlg file. 

➢ Analyse→Macromolecule→Choose pdbqt file. 

➢ Analyse→Conformations→Load. 

➢ Double click the desired conformation. 

➢ Analyse→Docking→Show Interactions. 

Proteins and ligand interaction was displayed. Zoom it and increase the contrast by 

holding right key and ctrl. Rapid energy evaluation was attained by pre-calculating 

the atomic resemblance potentials for each atom in the selected compounds. In the 

AutoGrid process, the target was enclosed on a three dimensional grid point and 

the energy of interface of the each atom in the compounds were encountered. The 

following docking factors were chosen for the Lamarckian genetic algorithm as 

follows: population size of 150 individuals, 2.5 million energy evaluations, 

maximum of 27000 generations, and number of top individuals to automatically 

survive to next generation of 1, mutation rate of 0.02, crossover rate of 0.8, 10 

docking runs, and random initial positions and conformations. The probability of 

performing local search on a single compound in the population was set to 0.06. 

AutoDock was run various times to obtain various docked conformations, and used 

to calculate the predicted binding energy. 
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SYNTHESIS 

In the present work the isatin derivatives were synthesized by the ketonicmannich 

base reaction, with the help of para formaldehyde and acetophenones. 

Scheme 1: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

compound R1 R2 R3 

IS1 H OCH3 H 

IS2 H Cl H 

IS3 H OH H 

IS4 H CH3 H 

IS5 OH H OH 
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Synthesis of 1-[3-(4-methoxy phenyl)-3-oxopropyl]-1H-indole-2,3-dione 

A mixture of 8.8 g (0.073 mole) of methoxyacetophenone, 3.0 g (0.100 mole) of 

para formaldehyde, 8.0 g(0.044 mole) of isatin  and 10 cc(15ml) of absolute 

alcohol was heated on a steam-bath for 45 minutes. The mixture was cooled and 

the precipitated material (4.7 g) recrystallized from ethyl acetate. (F. F. BLICKEAND J. 

H. BURCKHAL  vol 64,P-453) 

Synthesis of 1-[3-(4-chlorophenyl)-3-oxopropyl]-1H-indole-2,3-dione 

 

A mixture of 8.8 g (0.073 mole) of  chloroacetophenone, 3.0 g (0.100 mole) of  

para formaldehyde, 8.0 g (0.044 mole) of isatin  and 10 cc(15ml) of absolute 

alcohol was heated on a steam-bath for 45 minutes. The mixture was cooled and 

the precipitated material (4.7 g) recrystallized from ethyl acetate.  

Synthesis of 1-[3-(4-hydroxyphenyl)-3-oxopropyl]-1H-indole-2,3dione 

 

A mixture of 8.8 g (0.073 mole) of hydroxyacetophenone, 3.0 g (0.100 mole) of 

paraformaldehyde, 8.0 g. (0.044 mole) of isatin  and 10 cc(15ml) of absolute 

alcohol was heated on a steam-bath for 45 minutes. The mixture was cooled and 

the precipitated material (4.7 g) recrystallized from ethyl acetate. 

Synthesis of 1-[3-(4-methylphenyl)-3-oxopropyl]-1H-indole-2,3-dione 

 

A mixture of 8.8 g(0.073 mole) of methyl acetophenone, 3.0 g (0.100 mole) of para 

formaldehyde, 8.0 g (0.044 mole) of isatin  and 10 cc(15ml)of absolute alcohol 

was heated on a steam-bath for 45 minutes. The mixture was cooled and the 

precipitated material (4.7 g) recrystallized from ethyl acetate.  

Synthesis of 1-[3-(3,5-dihydroxyphenyl)-3-oxopropyl]-1H-indole-2,3-dione 

 

A mixture of 8.8 g (0.073 mole) of  resacetophenone, 3.0 g (0.100 mole) of para 

formaldehyde, 8.0 g (0.044 mole) of isatin  and 10 cc(15ml)  of absolute alcohol 

was heated on a steam-bath for 45 minutes. The mixture was cooled and the 

precipitated material (4.7 g) recrystallized from ethyl acetate.  



EXPERIMENTAL SECTION PHASE II 
 

Department of Chemistry SRIPMS Page 3 
 

Scheme 2: 

 

 

compound R1 R2 R3 

NIS1 H OCH3 H 

NIS2 H Cl H 

NIS3 H OH H 

NIS4 H CH3 H 

NIS5 OH H OH 

Synthesis of 5-Nitro Isatin derivative 

3.4 mmol solution of isatin was prepared in 3.2 ml of conc. Sulphuric acid and then 

this solution was added drop wise into 3.4 mmol solution of nitric acid prepared in 

3.8 ml of conc. Sulphuric acid over a period of 1 hour whilst the temperature was 

maintained between 0 to 5°C. The reaction mixture was poured into 25 ml of ice 

water and precipitates were collected followed by its washing with water. The 
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crude 5-nitro isatin was purified by re-crystallization with ethyl acetate.( H. 0. 

CALVERY,’ C. R. NOLLERAND ROGERADAM vol64 P-3058) 

Synthesis of 1-[3-(4-methoxyphenyl)-3-oxopropyl]-5-nitro-1H-indole-2,3-dione 

A mixture of 8.8 g(0.073 mole) of methoxyacetophenone, 3.0 g(0.100 mole) of 

para formaldehyde, 8.0g (0.044 mole) of nitro isatin  and 10 cc(15ml) of absolute 

alcohol was heated on a steam-bath for 45 minutes. The mixture was cooled and 

the precipitated material (4.7 g) recrystallized from ethyl acetate.  

Synthesis of 1-[3-(4-chlorophenyl)-3-oxopropyl]-5-nitro-1H-indole-2,3-dione 

A mixture of 8.8 g(0.073 mole) of chloroacetophenone, 3.0 g (0.100 mole) of para 

formaldehyde, 8.0 g (0.044 mole) of nitro isatin  and 10 cc(15ml) of absolute 

alcohol was heated on a steam-bath for 45 minutes. The mixture was cooled and 

the precipitated material (4.7 g) recrystallized from ethyl acetate.  

Synthesis of 1-[3-(4-hydroxy phenyl)-3-oxopropyl]-5-nitro-1H-indole-2,3-

dione 

A mixture of 8.8 g (0.073 mole) of hydroxyacetophenone, 3.0 g(0.100 mole) of 

para formaldehyde, 8.0 g(0.044 mole) of nitro isatin  and 10 cc(15ml) of absolute 

alcohol was heated on a steam-bath for f45 minutes. The mixture was cooled and 

the precipitated material (4.7 g) recrystallized from ethyl acetate.  

Synthesis of 1-[3-(4-methyl phenyl)-3-oxopropyl]-5-nitro-1H-indole-2,3-dione 

A mixture of 8.8 g(0.073 mole) of methyl acetophenone, 3.0 g(0.100 mole) of para 

formaldehyde, 8.0 g(0.044 mole) of nitro isatin  and 10 cc(15ml)of absolute 

alcohol was heated on a steam-bath for 45 minutes. The mixture was cooled and 

the precipitated material (4.7 g) recrystallized from ethyl acetate.  

Synthesis of 1-[3-(4-dihydroxy phenyl)-3-oxopropyl]-5-nitro-1H-indole-2,3-

dione 

A mixture of 8.8 g(0.073 mole) of dihydroxyacetophenone, 3.0 g (0.100 mole) of 

para formaldehyde, 8.0 g(0.044 mole) of nitro isatin  and 10 cc(15ml) of absolute 
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alcohol was heated on a steam-bath for 45 minutes. The mixture was cooled and 

the precipitated material (4.7 g) recrystallized from ethyl acetate. 

 

SCHEME 3: 

 

 

 

 

compound R1 R2 R3 

CIS1 H OCH3 H 

CIS2 H Cl H 

CIS3 H OH H 

CIS4 H CH3 H 

CIS5 OH H OH 
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Preparation of 5-Chloro-lH-indole3,3-dione (5-Chloroisatin): 

 To a mixture of isatin (2.94 g, 20 mmol) and 9 mmol of TCCA (2.09 g, 9 mmol) 

in an ice bath, 12 mL of H2SO4 was added dropwiseover a 5 minute period with 

magnetic stirring. The mixture was kept in an ice bath under stirring for 15 

minutes. The mixture was then poured into cracked ice. The crystals were collected 

and washed with cold water. (N. M. Ribeiro et al., 2004) 

Synthesis of 5-chloro-1-[3-(4-methoxyphenyl)-3-oxopropyl]-1H-indole-2,3-

dione 

 

A mixture of 8.8 g (0.073 mole) of methoxyacetophenone, 3.0 g(0.100 mole) of 

para formaldehyde, 8.0 g(0.044 mole) of chloroisatin  and 10cc(15ml) of absolute 

alcohol was heated on a steam-bath for 45minutes. The mixture was cooled and the 

precipitated material (4.7 g) recrystallized from ethyl acetate.  

Synthesis of 5-chloro-1-[3-(4-chlorophenyl)-3-oxopropyl]-1H-indole-2,3-dione 

 

A mixture of 8.8 g (0.073 mole) of chloroacetophenone, 3.0 g(0.100 mole) of para 

formaldehyde, 8.0 g(0.044 mole) of chloroisatin  and 10 cc(15ml) of absolute 

alcohol was heated on a steam-bath for 45 minutes. The mixture was cooled and 

the precipitated material (4.7 g) recrystallized from ethyl acetate.  

Synthesis of 5-chloro-1-[3-(4-hydroxyphenyl)-3-oxopropyl]-1H-indole-2,3-

dione 

 

A mixture of 8.8 g (0.073 mole) of hydroxyacetophenone, 3.0 g (0.100 mole) of 

para formaldehyde, 8.0 g(0.044 mole) of chloroisatin  and 10 cc(15ml) of absolute 

alcohol was heated on a steam-bath for 45 minutes. The mixture was cooled and 

the precipitated material (4.7 g) recrystallized from ethyl acetate. 
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Synthesis of 5-chloro-1-[3-(4-methylphenyl)-3-oxopropyl]-1H-indole-2,3-dione 

 

A mixture of 8.8 g(0.073 mole) of methyl acetophenone, 3.0 g(0.100 mole) of 

paraformaldehyde, 8.0 g(0.044 mole) of chloroisatin  and 10 cc(15ml) of absolute 

alcohol was heated on a steam-bath for 45 minutes. The mixture was cooled and 

the precipitated material (4.7 g) recrystallized from ethyl acetate. 

Synthesis of 5-chloro-1-[3-(4-di hydroxyphenyl)-3-oxopropyl]-1H-indole-2,3-

dione 

 

A mixture of 8.8 g (0.073 mole) ofdihydroxyacetophenone, 3.0 g(0.100 mole) of 

para formaldehyde, 8.0 g(0.044 mole) of chloroisatin  and 10 cc(15ml) of absolute 

alcohol was heated on a steam-bath for 45 minutes. The mixture was cooled and 

the precipitated material (4.7 g) recrystallizedethylacetatel. 
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PHASE III 

MAO-A enzyme isolation and activity. 

MAO a flavoenzyme of the mitochondrial outer membrane, plays an important role 

in the regulation of the metabolism of exogenous amines, the level of 

neurotransmitters (such as dopamine, norepinephrine and serotonin) and 

intracellular amine stores. MAO exists as two isoforms (MAO-A and MAO-B), 

according to their substrate specificity and sensitivity to specific inhibitors. MAO-

A preferentially oxidizes norepinephrine (NE) and serotonin(5-HT). 

PROCEDURE  

Tissue preparation 

 Male Wistar rats weighing 150–250 g are sacrificed and the brains rapidly were 

removed. Whole brain minus cerebellum is homogenized in 9 volumes of ice-cold, 

phosphate-buffered 0.25 M sucrose, using a Potter-Elvejhem homogenizer. The 

homogenate is centrifuged at 1000 g for 10 min and the supernatant decanted and 

recentrifuged at 18000 g for 20 min. The resulting pellet (P2) is resuspended in 

fresh 0.25 M sucrose and recentrifuged at 18000 g for 20 min. The washed pellet is 

resuspended in the original volume of 0.25 M sucrose and serves as the tissue 

source for mitochondrial monoamine oxidase. 

Direct spectrophotometry 

The activities of MAO-A were determined by UV-Vis spectrophotometry. Briefly, 

800 ml of a solution containing potassium phosphate buffer (pH 7.60, 100 mM), 

200 ml of MAO protein homogenates 5- HT (for detecting MAO-A) was incubated 

for 20 min at 37 oC. The reaction was started by adding 100 mM buffer and 200 ml 

of 0.02 M 5-HT, and incubated for 60 min. The reaction  was stopped by adding 

200 ml of 10% perchloric acid or 200 ml of 2MHCl. N-butyl acetate (for detecting 

MAO-A) was added to the reaction solution; and the tubes were vortexed for 3 

min. Following centrifugation at 10,625 g for 6 min, absorbance was determined 

using a spectrophotometer at 280 nm MAO-A. 
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RESULT AND DISCUSSION 

Phase I 

LEAD OPTIMIZATION 

Lead optimization is done by evaluating the, 

• Drug likeliness score  

• Pre ADMET 

a) Drug likeliness 

 For the better oral absorption of the ligands the drug likeliness scores are 

constructed by getting information about solubility, diffusion, Log P, molecular 

weight etc. One of the ideal methods for this is using Lipinski’s rule of five with 

the molinspiration server. 

 The lead optimization of the ligands shows that none of the derivatives had 

any violations of the rule. These compounds when administered orally will more 

likely have a good absorption or permeation.   
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Lipink’s rule of five for isatin derivatives 

Table 3: Drug likeliness scores of IS1-IS5,NIS1-NIS5,CIS1-CIS5 ligands 
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01 IS1 2.37 65.38 23 309.32 5 0 0 5 

02 IS2 2.99 56.15 22 313.74 4 0 0 4 

03 IS3 1.84 76.38 22 295.29 5 1 0 5 

04 IS4 2.77 56.15 22 293.32 4 0 0 4 

05 IS5 1.29 96.60 23 311.29 6 2 0 4 

06 NIS1 2.31 111.20 26 354.32 8 0 0 6 

07 NIS2 2.93 101.97 25 358.74 7 0 0 5 

08 NIS3 1.77 122.20 25 340.29 8 1 0 5 

09 NIS4 2.70 101.97 25 338.32 7 0 0 5 

10 NIS5 1.22 142.43 26 356.29 9 2 0 5 

11 CIS1 3.03 65.38 24 343.77 5 0 0 5 

12 CIS2 3.65 56.15 23 348.19 4 0 0 4 

13 CIS3 2.49 76.38 23 39.74 5 1 0 4 

14 CIS4 3.42 56.15 23 327.77 4 0 0 4 

15 CIS5 1.94 96.60 24 345.74 6 2 0 4 
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Table 4 :Preadmet properties of  IS1-IS5 
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Table 5 :Preadmet properties of NIS1-NIS5 
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Table 6 :Preadmet properties of CIS1-CIS5 
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DOCKING 

 The docking results of 2BXS with ligands IS1-IS5,NIS1-NIS5,CIS1-

CIS5is reported below. The binding sites and the active sites represented in the 

snapshots and the binding energy was found to be more when compared to the 

standard   

 Table 7:binding energies of IS1-IS5,NIS1-NIS5,CIS1-CIS5 ligands with 

MAO-A (2BXS) 

SL.NO COMPOUND CODE 
BINDING ENERGY 

(Kcal/mol)ΔG 

01. IS1 -8.76 

02. IS2 -8.15 

03. IS3 -8.52 

04. IS4 -8.17 

05. IS5 -8.76 

06. NIS1 -7.62 

07. NIS2 -8.56 

08. NIS3 -8.35 

09. NIS4 -7.65 

10. NIS5 -8.06 

11. CIS1 -8.91 

12. CIS2 -8.76 

13. CIS3 -7.62 

14. CIS4 -7.87 

15. CIS5 -8.06 

16. SELEGILINE -6.49 
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IS1 Binding with MAO A(2BXS.PDB) 

 

 

 

 

 

 

 

Fig.3: Binding energy = -8.76 kcal/mol 

IS2 Binding with MAO A(2BXS.PDB) 

 

Fig.4: Binding energy = -8.15 kcal/mol 
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IS3Binding  with MAO A(2BXS.PDB) 

 

Fig.5: binding energy=-8.52 kcal/mol 

IS4Binding with MAO A (2BXS.PDB) 

 

Fig.6: Binding energy= -8.17 kcal/mol 
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IS5 Binding with MAO A (2BXS.PDB) 

 

Fig.7: Binding energy= -8.76 kcal/mol 

NIS1 Binding with MAO A (2BXS.PDB) 

 

Fig.8: Binding energy = -7.62 kcal/mol 
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NIS2 Binding with MAO A (2BXS.PDB) 

 

Fig.9: binding energy = -8.56 kcal/mol 

NIS3 Binding with MAO (2BXS.PDB) 

 

Fig.10: binding energy = -8.35 kcal/mol 
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NIS4Binding with MAO (2BXS.PDB) 

 

Fig.11: binding energy = -7.65 kcal/mol 

NIS5Binding with MAO (2BXS.PDB) 

 

Fig.12: binding energy = -8.06kcal/mol. 
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CIS1Binding with MAO (2BXS.PDB) 

 

Fig.13: binding energy = -8.91 kcal/mol 

CIS2Binding with MAO (2BXS.PDB) 

 

 

 

 

 

 

 

Fig.14: Binding energy= -8.76kcal/mol 
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CIS3Binding with MAO (2BXS.PDB) 

 

Fig.15: Binding energy= -7.62kcal/mol 

 

CIS4  Bindingwith MAO (2BXS.PDB) 

 

Fig.16: binding energy = -7.87kcal/mol 
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CIS5Binding  with MAO (2BXS.PDB) 

 

Fig.17:binding energy = -8.06kcal/mol 

Selegiline Binding  with MAO (2BXS.PDB) 

 

Fig.18: binding energy= -6.49kcal/mol. 
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 All the ligands IS1-IS5, NIS1-NIS5,CIS1-CIS5showed excellent binding 

interactions with the MAO(2BXS.PDB). Among the isatin derivatives 

CIS1,CIS2,IS5,IS1 has shown the highest binding energies -8.91,-8.79,  -8.76,-

8.76 kcal/mol when compared to the standard selegilineshown the binding energy 

of -6.49 kcal/mol. 
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RESULTS AND DISCUSSION 

All the fifteen new compound(IS1-IS5, NIS1-NIS5, CIS1-CIS5) obtained through 

three schemes were prepared in good yield and their physical (melting point and 

TLC) and spectral (UV, IR, Mass,NMR)data were evaluated. 

Recrystallisationsolvent: Ethyl acetate 

Solvent system: chloroform: benzene (1:1) 

Visualizing agent: Iodine vapour 
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Physical characterization 

Table 8: Physical characterization of isatin derivatives IS1-IS5,NIS1-NIS5,CIS1-

CIS5)  

 

 

Sl 

no. 

Comp 

Code. 

 

R1 

 

R2 

 

R3 

Molecular 

formula 

Molecular 

weight 

% 

Yield 

Melting 

point °C 

Rf 

value  

1 IS1 H OCH3 H C18H15O4N 309.32 79 239.2 0.62 

2 IS2 H Cl H C17H12O3N1Cl 313.74 80 240.6 0.81 

3 IS3 H OH H C17H13O4N 295.29 75 241.1 0.79 

4 IS4 H CH3 H C18H15O3N 293.32 70 242.5 0.66 

5 IS5 OH H OH C17H13O4N 311.29 81 240.4 0.85 

6 CIS1 H OCH3 H C18H14O4N1Cl 354.32 76 238.2 0.65 

7 CIS2 H Cl H C17H11O3N1Cl2 358.74 73 241.6 0.83 

8 CIS3 H OH H C17H12O4N1Cl 340.29 76 242.8 0.73 

9 CIS4 H CH3 H C18H14O3N1Cl 338.32 71 240.3 0.87 

10 CIS5 OH H OH C17H12O4N1Cl 356.29 83 245.5 0.62 

11 NIS1 H OCH3 H C18H14O6N2 343.77 77 240.4 0.74 

12 NIS2 H Cl H C17H11O5N2Cl 348.19 69 243.4 0.82 

13 NIS3 H OH H C17H12O6N2 39.74 80 241.6 0.80 

14 NIS4 H CH3 H C18H15O5N2 327.77 67 240.8 0.78 

15 NIS5 OH H OH C17H13O6N2 345.74 80 242.6 0.75 
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SPECTRAL DATA  

The structures of compounds synthesized during the present study were established 

on the basis of the physical data, IR, UV, NMR, and MASS spectral data.The 

purity of the compounds was established by single spot on TLC plates. 

 

Compound code: IS1 

 

Chemical name :  1-[3-(4-methoxyphenyl)-3-oxopropyl]-1H-indole-2,3-                              

dione 

  

UV Spectrum 

Solvent used :  acetone  

 λmax                                      : 346nm  

 IR (KBr, νmax in cm-1)  :  C=O 1750, benzene 1515, C-H bending 2051, C=C 

stretching 1620, C-N 1279.  

 

(Align properly) 
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                                         Fig .18: UV spectrum of IS1 

  

 
                                     

                                      Fig .19:  IR spectrum of IS1 
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                            Compound code: NIS3 

 

 

Chemical name :  1-[3-(4-hydroxyphenyl)-3-oxopropyl]-5-nitro-1H-indole-

2,3-dione 
 

UV Spectrum 

Solvent used :  acetone  

 λmax                                      :  330nm  

 IR (KBr, νmax in cm-1)  : NO2 1331, C=O 1750, benzene 1515, C-H 2051, 

                                            C=C 1620 
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                                     Fig .20: UV spectrum of NIS3 

 

    
                                       Fig.21: IR spectrum of NIS3 
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                                          Compound code: CIS3 
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Chemical name :5-chloro-1-[3-(4-methoxyphenyl)-3-oxopropyl]-1H-indole-2,3-

dione 

 

 

UV Spectrum 

Solvent used :  acetone  

 λmax                                      :  330nm  

 IR (KBr, νmax in cm-1)  : C=O 1750, benzene 1515, C-H 2051, C=C 1620 

                                               C-Cl strecting 765. 
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                                   Fig.22: UV spectrum of  CIS1 

  

 
                            Fig .23:IR spectrum of CIS1 
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INVITROENZYME INHIBITORY STUDY 

Invitro MAO-A inhibitory activity using isatin derivatives and standard 

MAO activity has been determined by measurement of oxygenconsumption and 

the concentration of hydrogen peroxide (H2O2) oran oxidized monoamine product 

based on their catalytic oxidativedeamination of monoamines. 

RCH2NR1R2+H2O +O          RCHO +NR1R2+H2O2
 

The measurement of oxygen consumption by an oxygensensitive electrode requires 

specialized equipment, and is notappropriate for the rapid measurement of a large 

numbers ofsamples. The H2O2 method is insensitive and not specific for 

MAO, because most biological and synthetic compounds alsoabsorb at 230 nm. 

Additionally, complicated cellular processescould influence the concentration of 

H2O2. Aldehydes,which are oxidized monoamine products, are produced by the 

incubation of amine substrates with MAO and these can be detectedby 

spectrophotometry. 

The enzyme inhibitory activity of the 9synthesised compound was evaluated by   

invitroprocedure using monoamino oxidase A (MAO-A) enzyme extracted from 

rat brain.The results were tabulated as follows. 
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Table 9: MAO A inhibitory activity of different concentrations of isatin 

derivatives and standard selegline 
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The synthetic derivatives of isatin shows that MAO-A inhibitory activity at a 

varying concentrations (100,200,400,800,1600 µg/ml) there was dose dependent 

increase in the percentage inhibition for all the concentrations.  

• The CIS1 at concentration 100 µg/ml showed 47.65 and for 1600 µg/ml it 

become 77.17 the IC50 value for CIS1 found to be 160 µg/ml. 

• The IS3 at concentration 100 µg/ml showed 33.13 and for 1600 µg/ml it 

become 88.07  the IC50 value for IS3 found to be 300 µg/ml. 

• The NIS3 at concentration 100 µg/ml showed 35.25 and for 1600 µg/ml it 

become75.47±0.08 the IC50 value for NIS3 found to be 450 µg/ml. 

• The selegline at concentration 100 µg/ml showed 29.26±0.47and for 1600 

µg/ml it become 65.34±0.73 the IC50 value for selegline found to be 780 

µg/ml. 
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SUMMARY AND CONCLUSION 

      The present work was focused on the design, docking, synthesis and 

evaluation of anti-depressant activity of isatin derivatives as possible MAO-A 

inhibitors. 

In-silico studies 

• Selection of the target  

The enzyme involved in the anti-depressant was MAO-A was selected as the drug 

target of the study. The corresponding enzyme were obtained from the protein 

databank and their accession code were 2BXS. 

 

• Lead optimization 

The fifteen modified ligand IS1-IS5,CIS1-CIS5,NIS1-NIS5 were subjected to in-

silicolead optimization. The ligand were optimized for evaluating oral 

bioavailability by utilizing the Molinspiration server. Lead optimization revealed 

that all the  

 

• Docking 

 The optimized leads were subjected to docking studies using Autodock 

4.2 and the interactions of the derivatives with active sites of the enzyme were 

studied.The derivative were subjected to interactions with MAO-A. Selegline was 

used as the standard ligand. Most of the derivatives were interacting with the key 

active sites of the MAO-A(2BXS)with superior dock values or binding energies 

when compared to the standard (selegline).  

Bindingsites Arg51A,Cys406A,Tyr407A, Gly66A, Ala44A, Ile273A, 

Gly67A and FAD. 
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Synthesis 

 In this present work total of fifteen newisatin derivatives were synthesized. 

Scheme 1 

 In this scheme five compounds were synthesized by treating isatin 

with  corresponding acetophenone and with para formaldehyde in the presence of 

ethanol to give the product 

Scheme 2 

 In this scheme five compounds were synthesized by treating nitro 

isatin with corresponding acetophenone and with para formaldehyde in the 

presence of ethanol to give the product 

Scheme 3 

 In this scheme five compounds were synthesized by treating 

chloroisatin with corresponding acetophenone and with para formaldehyde in the 

presence of ethanol to give the product 

Characterization  

 Melting point of all the newly synthesized compound were 

determined. Rf values were determined by fixing various suitable solvent system 

on pre- coated silicagel-G. The solvent system used was chloroform: benzene 

(1:1).  

Compound BINDING ENERGIES 

IS1 -8.76 kcal/mol 

NIS3 -8.35 kcal/mol 

CIS1 -8.91 kcal/mol 

Selegline -6.46 kcal/mol 
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Enzyme Inhibitory activity 

Anti-depressant activity  

 The representative compounds from isatin derivatives were screened for 

anti-depressant activity was performed by in-vitro anti-depressant assay technique 

by using MAO-A. 

Compound IC50 

IS1 330 µg/ml 

NIS3 450 µg/ml 

CIS1 160 µg/ml 

Selegline 780 µg/ml 

 

CONCLUSION    

• The present studyestablishes that computational tools help in minimizing 

 the tedious process in drug discovery. 

• Molinspiration  was utilized for filtering the compounds and selecting the 

 lead compounds. 

• The binding energy obtained from docking study further confirmed the 

 possibility of the affinity of the selected leads towards the enzyme  

 MAO- A. 

• Using the schemes various isatin derivatives were synthesized with good 

 yield. 

• Structure of the synthesized compounds were confirmed by Melting point, 

TLC, UV, IR, NMR and MASS spectra. 

• Among the compounds screened for antidepressant activity CIS1 showed 

 the highest activity. 
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 Thus, the present study depicts that the utilization of computer aided drug  

design is an effective tool in predicting the effectiveness of a series of  isatin 

derivative compounds under study and thus can result in the design of potent 

antidepressant agents. 
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